
iISystem Wiper User Guide
iISystem Wiper allows you to clear the history of your activites from you computer.    

Many programs store information about your activieties on the 
computer.    Some of this information is easy to clear, such as the History, but other 
information can be hard to locate and clear, for example the cookie index file.    iISystem 
Wiper allows you to clear this information with a click of a button.    In addition to the lack of 
privacy this stored information causes, the fileas can also take up large amounts of space on 
you hard drive.    Internet Explorer's temporary files can take up hundreds of megabytes of 
space.    iISystem Wiper will even automate the process of wiping clean your computer.    All 
you have to is select what items you want cleared and iISystem Wiper will clear your 
computer everytime it is shutdown.

Getting Started
Saving and Loading Settings

Discription of Items
Plugins

Secure Delete
Broken Links

Junk Files
Scheduler
Options

Common Errors

Goto the iISoftware WWW page



Whats New in 2.3
· Scheduler added
· New Plugins Added

Whats New in 2.2
· Plugin Verification Added
· Secure Delete Added allows secure deletion of files and can wipe free space
· Files can now be Recycled, Deleted, or Securly Deleted
· Added Hot Key to start wipe
· Selecting Delete Temporary Files in Internet Explorer Page no longer deletes cookies
· Added Broken Link Search
· Added Junk File Search
· Added 'Change Dir' Button on some items
· Bug in Plugin System Fixed
· Added Items for Netscape
· Cookie Protection

Whats New in 2.1
· Plugin System Added
· Windows 95 Recycle Bin Problem Fixed

Whats New in 2.0
· Added Office Recent File List Items
· Automatically Store Checked Items
· Wipe On Shutdown feature added
· User Interface redone
· · · ·



Internet Explorer
History
Typed URLs
Temporary Files
Cookies
Cookies Index File

Windows
Recent Documents List
Find File History
Find Computer History
Run History
Temporary Files
Recycle Bin

Windows Media Player
Recent File List
Recent URL List
Library

Peer-2-Peer Programs
Morpheus Search History
Gnucleus Search History
IMesh Search History
Kazaa Databases

Microsoft Office
Access Recent File List
Excel Recent File List
Powerpoint Recent File List
Word Recent File List



Clear History - Internet Explorer keeps track off all the web sites you visit, and keeps 
their addresses stored in the History.    These stored web page addresses are open for 
anyone who uses your computer to see.    Choosing this option erases the history from your 
computer.

Make sure Internet Explorer and all programs that use Internet Exporer Libraries 
are closed



Clear Typed URLs - Any Web Addresses you type into Internet Explorer are stored in a 
drop down menu on the Address Bar.    This option clears the list of URLs.

Make sure Internet Explorer and all programs that use Internet Exporer Libraries 
are closed



Clear Temporary Files - Internet Explore stores files, including pictures, sound files, 
video files, and text from sites you visit, so that they will load faster the next time you visit 
the site.        These files are stored on your hard drive for anyone to see, and they can often 
take up a large amount of space on your hard drive.    Choosing this option deletes all the 
temporary files kept by Internet Explorer.

Make sure Internet Explorer and all programs that use Internet Exporer Libraries 
are closed



Clear Cookies - Many web sites send information to your computer to be kept in the form 
of cookies.    Often cookies contain information such as, usernames, passwords, and user 
preferences, and some webpages use cookies to track your activities on the Internet.    
Choosing this option clears these cookies.

Make sure Internet Explorer and all programs that use Internet Exporer Libraries 
are closed



Clear Cookie Index File - In addition to the text file form of cookies, Internet Exporer 
also keeps a log file of cookies created on your computer.    This option clears this log file, 
but requires a reboot for Internet Explorer to work properly again.



Clear Documents List - Windows keeps a list of recently used files in the Start Menu.    
This option clears the list.



Clear Find File History - Every file you search for is saved in the recent search list in 
the Find Window.    This options clears the list.



Clear Find Computer History - Every computer you search for is saved in the recent 
search list in the Find Window.    This options clears the list.



Clear Run History - Every program you run using the Run Dialog Box is saved in a drop-
down list.    This option clears the list.



Clear Temporary Files - Many applications use the Temporary Files folder to store 
temporary files.    This clears the files in the Temporary Files folder.



Empty Recycle Bin - When a file is deleted in Windows it is first sent to the Recycle Bin, 
but not actually deleted until the Recycle Bin is emptied.    This option empties the Recycle 
Bin. 

Note:    This function currently does not work in Windows 95



Clear Media Player Recent File List -This option clears the list of files that have 
recently been opened by Windows Media Player.



Clear Media Player Recent URL List -This option clears the list of URLs that have 
recently been opend by Windows Media Player.



Clear Media Player Library - Windows Media Player stores a list of files that Windows 
Media Player can run in its Media Library.    It also stores media file that you have deleted 
from your computer.    This option deletes the library information.



Clear Morpheus Search History - Morpheus keeps a list of every file you search for in 
a drop-down list.    This option clears the list.



Clear Gnucleus Search History - Gnucleus programs keep a list of every file you 
search for.    This option clears the list.



Clear IMesh Search History - IMesh keeps a list of every file you search for.    This 
option clears the list.



Clear KaZaA Databases-  Kazaa keeps a database of all files that you have downloaded. 
This option clears the database.



Clear Access Recent File List - Clears the recently used file list for Access.



Clear Excel Recent File List - Clears the recently used file list for Excel.



Clear Powerpoint Recent File List - Clears the recently used file list for Powerpoint.



Clear Word Recent File List - Clears the recently used file list for Word.



Wipe System On Shutdown - To have iISystem Wiper wipe you system automatically 
click on the Options Tab and select the Wipe System on Shutdown option.    When this 
option is selected iISystem Wiper will wipe all the items that are selected when your 
computer is shuting down.    The iISystem Wiper program must be running at system 
shutdown for it to start a wipe.



Automatically Check for Update - This option make iISystem Wiper automatically 
contact the iISoftware servers to see if a new version is avalable.    If you do not want 
iISystem Wiper to automatically contact the servers simply go to the Options tab and 
unselect the Automatically Check for Update option.



Run At Startup - This option makes iISystem Wiper run when the computer is booted.    
If this option is selected you will see a trash can icon in the system tray.    If you want to 
change this option go to the Options tab and select/unselect the Run at Startup option.



Getting Started with iISystem Wiper

To wipe items from you computer using iISystem Wiper select the items you want wiper 
and press the Start button.    You will see a box appear that will show you the progress of 
the wipe.    Thats all that it takes to wipe you system clean with iISystem Wiper.    iISystem 
Wiper can also wipe your system automatically using the Wipe on Shutdown option. 



Plugins - Plugins are customizable wipe items that allow you to create and edit clear items 
for your specific needs.    iISystem Wiper comes with plugins for many popular applications 
and a Plugin Editor which lets you edit and create your own plugins.    To run a plugin press 
the check box next to the plugin and press the Start button when you want to clear.

Creating Your Own Plugin -  To create your own plugin go to the Plugins tab and press 
the Add Plugin button.    The Plugin Editor will load with blank fields for you to fill in.



The Plugin Editor has fields for the name of the plugin, a discription of what the plugin does, and who 
wrote the plugin.    The Items list contains the list of items the plugin will clear.    To add an item to a plugin 
press the Add Item button.    The Add Item Wizard will apear and guide you through making an item.    
For a discription of the different item types and specific information on creating items click here.    To edit 
an item select an item in the Items list and press the Edit Item button.    To delete an item select the item 
in the list and press the Delete Item button.    When you have created the items for the plugin and filled in 
the Name, Discription, and Author field press the Save As button to save your plugin.

Editing Plugins - To edit a plugin select the plugin from the Plugins list and press the Edit Plugin 
button.    Plugin Editor will load with the plugin settings.    You can edit the settings of the plugin and then 
save by pressing the Save button.



Deleting Plugins -    To delete a plugin select the plugin in the Plugin list and press the Delete Plugin 
button.



The first step in creating an item is the enter the Item Name and select the Item Type.    
Below are link to discriptions of the different item types and further instuctions for those 
items.

Plugin Item Types
Delete Registry Value
Delete Registry Key
Delete File
Clear Directory
Clear Directory found in Registry
Delete Registry Values Containing
Delete Registry Keys Containing



Delete Registry Value -  A Delete Registry Value Item delete a single value from the 
registry.    You can use Regedit to find values.    When you are done press the Finish button 
to finish adding the item.

Root Key - Select the root key of the value from the list.

SubKey - Enter the rest of the key were the value is located.

Value - The name of the value to be deleted.



Delete Registry Key -  A Delete Registry Key Item delete a entire Key from the registry. 
You can use Regedit to find keys.    When you are done press the Finish button to finish 
adding the item.

Root Key - Select the root key of the value from the list.

SubKey - Enter the rest of the key to be deleted.



Delete File -  A Delete File Item deletes a file from your computer.    When you are done 
press the Finish button to finish adding the item.

File - Enter the full file name of the file to delete.

Browse - Pressing the Browse button allows you to browse for a file.



Clear Directory -  A Clear Directory Item clear all of the files in a directory.    The File 
field allows you to clear only files with a certain extention.    When you are done press the 
Finish button to finish adding the item.

Directory - Enter the full path of the directory to clear.

Browse - Pressing the Browse button allows you to browse for a directory.

File - This optional field allows you to only delete file with a certain extension.    For example if you only 
want executable files deleted add .exe to this field.    If you want all files to be deleted leave this field 
blank.



Clear Directory Found in Registry -  Some applications store directory paths in the 
Registry.    A Clear Directory Found in Registry Item will first load the directory path from the 
value and then clear all the files in the directory as is done with a Clear Directory Item.

Root Key - Select the root key of the value from the list.

SubKey - Enter the rest of the key were the value is located.

Value - The name of the value where the Directory path is stored.

File - This optional field allows you to only delete file with a certain extension.    For example if you only 
want executable files deleted add .exe to this field.    If you want all files to be deleted leave this field 
blank.



Delete Registry Value Containing -  A Delete Registry Value Containing Item deletes 
all the values in a key that contain a certain word.

Root Key - Select the root key of the value from the list.

SubKey - Enter the rest of the key were the value is located.

Value Contains - Partial text that the values to be deleted contain.    For example setting 
this field to "File" as in the picture would delete the values 'File2', 'OldFile', 'RecentFile', and 
'AAFileAA' because they all contain the word File.    This is not case sensative.



Delete Registry Key Containing -  A Delete Registry Key Containing Item deletes all 
the keys in a subkey that contain a certain word.

Root Key - Select the root key of the value from the list.

SubKey - Enter the rest of the key were the value is located.

Key Contains - Partial text that the keys to be deleted contain.    This is not case sensative.



Secure Delete -    The secure delete page allows you to delete files so they cannot be 
recovered by file recovery utilities.    Normally when a file is deleted in windows the data 
remains undeleted and can be later recovered.    The secure delete function deletes files by 
overwriting their data with random information.    iISystem wiper uses the Department of 
Defense clearing and sanitizing standard DOD 5220.22-M to wipe the files data.    iISystem 
Wiper can also wipe a disks free space to clear data of files that were not deleted with a 
secure delete function.    You can set the number of times iISystem Wiper overwrites the 
data by changing the Secure Delete Passes Option. 



Options
Wipe System On Shutdown
Automatically Check for Update
Run At Startup
File Delete Method
Secure Delete Passes
Wipe Hot Key



Common Error Messages and Fixes

"The dynamic link library MFC42.DLL could not be found"
"THE ORDINAL 6880 COULD NOT BE LOCATED IN THE DYNAMIC LINK LIBRARY 
MFC42.DLL"
"The file is linked to missing export MFC42.DLL:6880"

Download MFC42.DLL into the Windows system directory. 
For Windows 95/98: c:\windows\system
For Windows NT/2000: c:\winnt\system32

"The file is linked to missing export SHELL32.DLL:SHEmptyRecycleBinA."
Download the newest version of Internet Explorer

Error clearing Internet Explorer History, Temporary File, or Cookies
Make sure that Internet Explorer is not running.    Other programs can also use Internet 
Explorer, which can cause the wipe to fail. 



File Delete Method - This option determines how file are deleted by iISystem Wiper.    
There are three options Recycle, Delete, and Secure Delete.

Recycle - When iISystem Wiper deletes a file with this option selected the file is sent to the 
Recycle Bin.    This option is useful if you are not sure you want the file deleted.

Delete - This option simply deletes the file from the computer.    This option is useful for 
when you are sure you want a file deleted, but do not care if others could possibly recover 
the file later.

Secure Delete - This option deletes the file and then securely overwrites the file so others 
can no longer recover the file.



Secure Delete Passes - This option determines how many times the Secure Delete 
Function overwrites the File with random data. 



Wipe Hot Key - This option allows you to set a hotkey to start a wipe.    iISystem Wiper 
must be running for the hotkey to work but only needs to be in the system tray. 



Broken Links -    The Broken Links Page allows you to search for links on the desktop and 
start menu that no longer point to a file.    Press the Search buton to start a search.

Search for Broken Links on - This options tells iISystem Wiper where to search for the Broken Links.

Ignore Links pointing to files on - Sometimes links point to file that are on a network drive or removable 
media and the link might appear broken.      This option allows you to ignore these links. 



Stop Search - Stops the current search.

Delete Selected File - Deletes all of the files thatare checked.

Select All - Checks all of the files in the list.

Properties - Allows you to see the properties of the highlighted file.    Usefull for seeing what file the link 
points to.

Delete Link File - Deletes only the highlighted file.

Clear Selections - Removes checks from all files in the list.

Invert Selection - Inverts the checks on all the files in the list. 



Junk Files -    The Junk Files Page allows you to search for temporary and junk files.    
Right click in the Extensions List to add or remove Extensions.    Press the Search buton 
to start a search.

Stop Search - Stops the current search.



Delete Selected File - Deletes all of the files thatare checked.

Select All - Checks all of the files in the list.

Delete File - Deletes only the highlighted file.

Clear Selections - Removes checks from all files in the list.

Invert Selection - Inverts the checks on all the files in the list. 

Properties - Allows you to see the properties of the highlighted file.

Open File - Opens the highlighted file.



Saving and Loading Settings - The Save and Load buttons allow you to save which 
items you want washed.    iISystem Wiper automatically save which items you have selected, 
but by using the Save and Load options you can easily recall other configurations.    To 
configuration file come with iISystem Wiper.    Clear.iis unselects all wipe items.    All.iis 
selects all of the wipe items.



Scheduler -  The scheduler allows you to have iISystem Wiper Pro automatically wipe at 
time interals, when the system is shut down, and when Internet Explorer and Netscape are 
closed.

Wipe on Timer - This option automatically starts a wipe after a set amount of time.

Wipe on System Shutdown - Wipe when the system is shutdown or when a user logs off.

Wipe on Internet Explorer - Wipes when the last Internet Explorer window is closed.

Wipe on Netscape Close - Wipes when the last Netscape window is closed.






